
Create and print labels for a mass mailing 
1. On the Tools menu, point to Letters and Mailings, and then click Mail Merge Wizard.  

2. Under Select document type, click Labels. 

The active document becomes the main document (main document: In a mail-merge operation in Word, the document that contains the text and 
graphics that are the same for each version of the merged document, for example, the return address or salutation in a form letter.).  

3. Click Next: Starting document.  

Tip 

If you're familiar with the mail merge feature or prefer to work outside the wizard, you can use the Mail Merge toolbar (toolbar: A bar with buttons and 
options that you use to carry out commands. To display a toolbar, use the Customize dialog box (point to Toolbars on the View menu and click 
Customize). To see more buttons, click Toolbar Options at the end of the toolbar.). The buttons are arranged in sequence from left to right. 

More step-by-step information 

The wizard guides you through the rest of the mail merge process. The following are more details, listed in step-by-step order.  

Set up and display your labels 

1. Do one of the following: 

Create a new sheet of labels 

1. Click Change document layout.  

2. Click Label options.  

3. In the Label Options dialog box, select the options you want, such as the label type and size, and then click OK. 

For Help on an option, click the question mark , and then click the option.  

Start with an existing sheet of labels 

1. Click Start from existing document.  

2. In the Start from existing box, select the document you want, and then click Open.  

3. If you don't see the document, click More files, and then click Open. In the Open dialog box, locate the document you want, and then click 
Open.  

Microsoft Word displays the document in the document window. If you decide to use a different label document instead, click Start from existing 
document, and then select a different document. If you want to change the layout, click Change document layout and then click Label options. 

2. Click Next: Select recipients.  

Locate or create a data source, and then select recipients 

1. Do one of the following: 

Connect to a Microsoft Outlook Contacts List 

1. Under Select recipients, click Select from Outlook contacts.  

2. Click Choose Contacts Folder.  

3. In the Select Contact List folder dialog box, click the contact list you want, and then click OK.  

All of the contacts in the folder appear in the Mail Merge Recipients dialog box, where you can refine the list of recipients to include in the merge. 

Connect to a different type of list, such as a database or Office Address List 

1. Under Select recipients, click Use an existing list.  

2. Click Browse.  

3. In the Select Data Source dialog box, locate and click the data source (data source: A file that contains the information to be merged into a 
document. For example, the list of names and addresses you want to use in a mail merge. You must connect to the data source before you can 
use the information in it.) you want. 

By default, Microsoft Word opens the My Data Sources folder.  

4. Click Open. 

Depending on the type of data source you select, other dialog boxes may appear asking you to request specific information.  

For example, if your data source is a Microsoft Excel worksheet that has information on multiple tabs, you need to select the tab containing the 
information you want, and then click OK.  

All of the entries in the data source appear in the Mail Merge Recipients dialog box, where you can refine the list of recipients to include in the 
merge. 

Create a simple new address list 

1. Under Select recipients, click Type a new list.  
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2. Click Create.  

3. In the New Address List dialog box, type the information you want to include for the first entry under Enter Address information; for 
example, title, names, and address information. You do not have to fill in every field.  

4. To complete the first entry and move on to a new entry, click New Entry.  

5. Repeat steps 3 and 4 until you've added all the address entries you want, and then click Close.  

6. In the Save Address List dialog box, type a name for the address list in the File name box, and select a folder to save the list in. 

By default, the address list is saved in the My Data Sources folder. It's best to keep the address list here because this is also the default folder 
in which Microsoft Word looks for data sources (data source: A file that contains the information to be merged into a document. For example, the 
list of names and addresses you want to use in a mail merge. You must connect to the data source before you can use the information in it.). So 
if you want to use this address list in a later mail merge, you won't have to navigate through files and folders to locate it.  

7. Click Save.  

All of the contacts in your new list appear in the Mail Merge Recipients dialog box, where you can refine the list of recipients to include in the 
merge. 

2. In the Mail Merge Recipients dialog box, select the recipients you want to include. 

How? 

1. Do one of the following: 

Use the check boxes to designate recipients 

This method is most useful if your list is short. 

Select the check boxes next to the recipients you want to include, and clear the ones next to the recipients you want to exclude.  

Tip 

If you know you want to include most of the list in your merge, clicking Select All first makes it easy to clear particular records. Similarly, if you 
want to include only a few records in the list, click Clear All, and then select the records you want. 

Sort items in the list 

This is useful if you want to see items in alphabetical or numeric order. 

Click the column heading of the item you want to sort by. For example, if you want to display the list alphabetically by last name, click the 
Last Name column heading.  

Filter items in the list 

This is useful if the list contains records that you know you don't want to see or include in the merge. Once you've filtered the list, you can use 
the check boxes to include and exclude records as described in the previous section. 

1. Click the arrow next to the column heading of the item you want to filter by.  

2. Click any of the following: 

(Blanks) displays all the records in which the corresponding field is blank.  

(Nonblanks) displays all the records in which the corresponding field contains information.  

If your data source contains records that share the same information, and there are ten or fewer unique values in the column, you can 
filter by specific information. For example, if there are multiple addresses that list Australia as the country/region, you can filter on 
Australia.  

The Mail Merge Recipients dialog box displays only the designated records. To display all the records again, click (All).  

2. Click OK to return to the Mail Merge Wizard. Microsoft Word will use the recipients you designated for the merge.  

Tips 

For advanced sorting and filtering, click the arrow next to any column name, and then click (Advanced). Use the Filter Records and Sort 
Records tabs to set up the sorting or filtering query you want.  

If you have installed address validation software, you can click Validate in the Mail Merge Recipients dialog box to validate your recipients' 
addresses.  

3. Click Next: Arrange your labels.   

Arrange the content of your labels 

1. Insert merge fields (merge field: A placeholder that you insert in the main document. For example, insert the merge field «City» to have Word insert a 
city name, such as "Paris," that's stored in the City data field.) where you want to merge names, addresses, and other information such as a postal 
bar code. 

How? 

1. In the main document (main document: In a mail-merge operation in Word, the document that contains the text and graphics that are the same 
for each version of the merged document, for example, the return address or salutation in a form letter.), click where you want to insert the 
field (field: A set of codes that instructs Microsoft Word to insert text, graphics, page numbers, and other material into a document automatically. 
For example, the DATE field inserts the current date.).  

2. Insert any of the following: 
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Address block with name, address, and other information 

1. Click Address block.  

2. In the Insert Address Block dialog box, select the address elements you want to include and the formats you want, and then click OK. 

For Help on an option, click the question mark , and then click the option.  

3. If the Match Fields dialog box appears, Microsoft Word may have been unable to find some of the information it needs for the address 
block. Click the arrow next to (not available), and then select the field from your data source (data source: A file that contains the 
information to be merged into a document. For example, the list of names and addresses you want to use in a mail merge. You must connect 
to the data source before you can use the information in it.) that corresponds to the field required for the mail merge.  

Greeting line 

1. Click Greeting line.  

2. Select the greeting line format, which includes the salutation, name format, and following punctuation.  

3. Select the text you want to appear in cases where Microsoft Word can't interpret the recipient's name, for example, when the data 
source (data source: A file that contains the information to be merged into a document. For example, the list of names and addresses you 
want to use in a mail merge. You must connect to the data source before you can use the information in it.) contains no first or last name for 
a recipient, but only a company name.  

4. Click OK.  

5. If the Match Fields dialog box appears, Word may have been unable to find some of the information it needs for the greeting line. Click the 
arrow next to (not available), and then select the field from your data source that corresponds to the field required for the mail merge.   

Other fields of information 

1. Click More items.  

2. Do one of the following: 

To select from address fields that will automatically map to corresponding fields in your data source (data source: A file that contains the 
information to be merged into a document. For example, the list of names and addresses you want to use in a mail merge. You must 
connect to the data source before you can use the information in it.), even if the data source's fields don't have the same name as your 
fields, click Address Fields.  

To select from fields that always take data directly from a column in a database, click Database Fields.  

3. In the Fields box, click the field you want.  

4. Click Insert, and then click Close.  

5. If the Match Fields dialog box appears, Microsoft Word may have been unable to find some of the information it needs to insert the field. 
Click the arrow next to (not available), and then select the field from your data source that corresponds to the field required for the mail 
merge.  

Note   If you insert a field from the Database Fields list, and then later switch to a data source that doesn't have a column with the same 
name, Word won't be able to insert that field information into the merged document. 

Electronic postage 

In order to add electronic postage, you must first install an electronic postage program, such as one you purchased from a service on the World 
Wide Web (World Wide Web (WWW): The multimedia branch of the Internet that presents not just text, but also graphics, sound, and video. On 
the Web, users can easily jump from item to item, page to page, or site to site by using hyperlinks.). 

1. Click Electronic postage. 

If you do not have an electronic postage program installed, Microsoft Word prompts you to install one and offers to connect to the Microsoft 
Office Web site. There you can get more information and links to other sites that offer electronic postage.  

2. Insert the postage according to the program's instructions.  

Postal bar code 

You must select a label or envelope type that supports the POSTNET bar code. 

1. Click Postal bar code.  

2. In the Insert Postal Bar Code dialog box, select the appropriate address fields.  

Note    The Postal bar code option only appears if you are using the U.S. language version of Microsoft Word. 

3. Repeat steps 1 and 2 for all the fields you want to insert.  

Notes 

You can't type merge field characters (« ») or insert them by using the Symbol command on the Insert menu.  

If the merge fields appear inside braces, such as { MERGEFIELD City }, then Microsoft Word is displaying field codes (field code: Placeholder text 
that shows where specified information from your data source will appear; the elements in a field that generate a field's result. The field code 
includes the field characters, field type, and instructions. ) instead of field results (field results: Text or graphics inserted in a document when 
Microsoft Word carries out a field's instructions. When you print the document or hide field codes, the field results replace the field codes.). This 
doesn't affect the merge, but if you want to display the results instead, right-click the field code, and then click Toggle Field Codes on the 
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shortcut menu.  

2. If you want, you can change the format of the merged data. 

How? 

To format merged data, you must format the merge fields (merge field: A placeholder that you insert in the main document. For example, insert the 
merge field «City» to have Word insert a city name, such as "Paris," that's stored in the City data field.) in the main document (main document: In a 
mail-merge operation in Word, the document that contains the text and graphics that are the same for each version of the merged document, for 
example, the return address or salutation in a form letter.). Don't format the data in the data source (data source: A file that contains the information 
to be merged into a document. For example, the list of names and addresses you want to use in a mail merge. You must connect to the data source 
before you can use the information in it.), because its formatting isn't retained when you merge the data into the document.  

1. In the main document, select the field containing the information you want to format, including the surrounding merge field characters («« »»).  

2. On the Format menu, click Font, and then select the options you want.  

Formatting by using field codes 

To control other aspects of formatting, press ALT+F9 to display field codes (field code: Placeholder text that shows where specified information from 
your data source will appear; the elements in a field that generate a field's result. The field code includes the field characters, field type, and 
instructions. ), and then add switches (switch: When working with fields, a special instruction that causes a specific action to occur. Generally, a 
switch is added to a field to modify a result.) to the merge fields. 

For example: 

To display the number "34987.89" as "$34,987.89," add the Numeric Picture switch (\#).  

To print client names in uppercase letters, add the Format switch (\*).  

To ensure that the merged information has the same font and point size you apply to the merge field, add the \* Charformat switch.  

To copy the format and layout of the first label to all the other labels on the page, click Update all labels.  

3. After you've completed the main document and inserted all of the merge fields, click Save As on the File menu. Name the document, and then click 
Save.  

4. Click Next: Preview your labels.  

Preview the labels and fine-tune the recipient list 

1. Preview the items. Do one of the following: 

To preview the items in order, click the arrow buttons  . Each record is previewed in the first label on the sheet.  

To locate and preview a specific item, click Find a recipient, and then enter the search criteria in the Find Entry dialog box. 

For Help on an option, click the question mark , and then click the option.  

2. If you want to fine-tune the recipient list — for example exclude a recipient — click Edit recipient list, and then make your changes in the Mail 
Merge Recipients dialog box.  

3. Click Next: Complete the merge.  

Complete the merge 

Do any of the following: 

Personalize individual labels 

To personalize individual items, you actually complete the merge, and then edit the information you want in the resulting merged document. 

1. Click Edit individual labels.  

2. In the Merge to New Document dialog box, select the records you want to merge. 

For Help on an option, click the question mark , and then click the option.  

3. Click OK. 

Microsoft Word creates and opens a new merged document. Your main document also remains open, and you can switch back to it if you want to 
make a change to all the items.  

4. Scroll to the information you want to edit, and make your changes. 

5. Print or save the document just as you would any regular document. 

Print the sheet of labels 

Do one of the following: 

If you personalized the items and the merged document is active 

1. On the File menu, click Print.  

2. Select the options you want. 

For Help on an option, click the question mark , and then click the option.  
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If you want to print directly from the Mail Merge Wizard 

1. In Step 6 of the Mail Merge Wizard (Complete the merge), click Print.  

2. In the Merge to Printer dialog box, do one of the following, and then click OK. 

To print all the documents, click All.  

To print the document that you see in the document window, click Current record.  

To print a range of documents, click From, and then type the record numbers in the From and To boxes.  

3. In the Print dialog box, select the options you want. 

For Help on an option, click the question mark , and then click the option.  

  

Save the sheet of labels for later use 

If you want to edit merged labels or save them for later use, you can collect them into a single document. 

1. Click Edit individual labels.  

2. In the Merge to a New Document dialog box, do one of the following, and then click OK. 

To merge all the documents, click All.  

To merge only the document that you see in the document window, click Current record.  

To merge a range of documents, click From, and then type the record numbers in the From and To boxes.  

Microsoft Word opens a single new document that contains all the individual labels. You can then save the document for later use, just as you would any 
regular document. 
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